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Provides written justification for cost estimate
Allows estimate to be replicable and traceable
Makes the estimate credible

Adds quality to estimate’s content

D

9

Another analyst should be able to recreate
your estimate using your documentation and
arrive at the same answer.

J
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« Comment Rows (Asterisk)
e Brackets

e Comment DEC

e Definition Editor

Document AS YOU GO!



==
—

Comment Rows



« WBS/CES Description Column

e Two very easy ways to do this...
— Manually type asterisk in first character position, or
— Use Comment WBS Icon (note the uncomment button)

3 &

u ACE 7.2 - [AF RAES PROGRAM 20080513 aceit - Methodology [BY20033M]]

:¥ File Edit Yiew Documentation Cale Cases  Beports  Tools  indow  Help

NEHS SR8 LB SR =K% =3 0 -

- A P10 cA-S-B 7%l R T E=EE 88 AEE ]
- Methodology 'E@B}vﬂvﬁﬁ@!

33 - S o2

Point Phasing

WWES/CES Description Approp | Unigue (D Estimate | Mathod Equation
26 COTS S | 5 0.416 * %
27 Product 1 | 3600 $0.102 *



o Titles of sections
— Good for organization
— Toggle

74 *Communications Subsystem

75  Comm Cost (FFP Contract)

76

77 "Software

78 Application #1 SLOC Caount

79 Application #2 5L0OC Count

80  Application # SLOC Count

81  Software Productivity

82  Software Development Rate (SR

=]

73
Calc: Paint Estimate Fg M
7 & | Cut Chrl+
53 Copy ChC
[ Paste Chrl+/
Paste Insert Ctrl+h4

(o Tosegooknat |

$2 Aesult Fomat..  Chl+Shift+A
}: Inzer Raw Cirl+F&

=n Delete Row F&

°°|L:':'|‘I'J_,‘3=:'.J'““‘|'““‘|'““‘.|'““J

oo
o

=l Auto-Height
Hide
Urhide

Lock
nlock

= 1

—

EEEET )
J o

b ethodalogy

*Canfiguration Functionz
“4F BAES Program E stimate

IMPUT WaRIABLES -
*Cammunications Subsystem il F't 1ar
¢Last Bows

G5 WYARRANTY

B AF RAES Program PRODUCTION PHASE
70 AF RAES Program OPERATIONS & SUPPORT PHAZ

71

72 INPUT WARIABLES

73

74 *Communications Subsystem
75 Comm Cost (FFP Contract)

-

3600 COMM_

3e00

Sy A
S A
Sy A
Sy P
S F



» Titles of fiscal year columns on phasing work screen

TRANSMITTER, FUEL FLOMW/

WES/CES Description FY 2013 FY 2014
*AVIONICS REMOVED QPA MTEF MX MANHOURS
INDICATOR, TEMPERATURE (ECT) 1 1314.8
308 TRAMNSDUCER, PRESSLURE RATIO (EFR) 1 3812.5
IMDICATOR, TACHOMETER (M1) 1 4765.6
4 B026.3




o Tracker
— For quick notes from version to version, or an excursion
— Add rows at top of ACE session
— Highlight
— Easy to see when opening your ACE session

WES/CES Description Appn

| “"MELISSAS TRACKER= |

2 *lUpdated Communications Subsystem Yariables

3 *Meed to put sk on vanables

4 *Meed to add documentation in keywoards screen
5

B

7
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Brackets



e Equation/Throughput Column
e Surround text with square brackets [ |

n_ ACE 7.1a - [AF RAES PROGRAM 20080513 aceit - Methodology [BY2003%M]]

ﬂ File Edit “iew Documentation Calc  Casez  Heports  Tools  “Window  Help

BEFETR I PET S =

: Aial ~10 cA-&-[B]Z U % BRI E=SSE LB AAEE
EMethodulug}I 'EEQ'@H'?%@
| = fe [y g+ 180 [SLOCMM]
WEBS/CES Description Approp | Unigue 1D E;;]r:lr:te iﬂheﬁlgdg Equation / Throughput F\Li;arl Unit
77 ["Software
78 Application #1 SLOC Count Swy APPT 4 500000 * C 4500
79  |Application #2 5LOC Count =Wy APPZ B 800000 * C Ea00
80  Application #3 SLOC Count SwAPP3 5 300000 * C 5300
81  Software Productivity vy PROD 180.000 * Cl 180 [SLDC-’MM]'
82 Software Development Rate (B 3600 Sy RATE P0.018 * C 18 2007 1
83

10
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e Use:
— Quick notes
— Cost Throughputs (BY, TY, SY phasing methods)
— Input Throughputs (I phasing method)

nt FPhasing . Fiscal
ate | Mathod Equation / Throughput Voar LIt
000~ C 5300
000~ C 180 [SLOCHM]
018~ C 18 2007
0oo = =Y [Cost Throughput]

I [Input Throughput]
0ao = = [Input Throughput]

I [Input Throughput]
1G4 C 160 2007

11
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Comment DECs

12



Dynamic Equation Columns

User-defined columns mostly used for immediate inputs
or calculations on a row

Makes session wider (i.e. more columns)
4 types of DECs:

— Normal
— Cost

— Comment
— Date

13



Holds comments and text that is not evaluated

Data stored here will not be used in any ACE
calculations for the row

Unlike using an asterisk, the ACE row will still calculate

Use:

— Select this when you do not want ACE to do anything with this
information except store it in the column

14



DEC Icon

Edit > Add DEC

I'Ilfli |

Add New DEC E3

Colurnrn Description: IEDmments

— Calurnn [dentifier

Unmuem;IEDMMENTS

Search |0 List...

¥ | Ehiarae llinstarces et ald (D e mew D

— Cell Content

¢ Cost - Column holds cost data and/or equations

¢ Momal - Column halds non-cost data and/or equations

' Comment - Column boldz commentz and text that is not evaluated

" Date - Column holdz dates of the form DD

[ ACE 7.1a - |AF RAES PROGRAM 20080513.aceit - Methodology (BY2008$M)] T St upiresulte b ehildieninte et panerts: o s calumt H
ﬂ File Edit “iew Documentation Casezs Reports  Tool:  Window Help
NEHE SR %@ I 9 ™33 605 <==|100% - 0K C | Hel
I C o ance =
i 210 <Al B 2 T|% (8BRS E P
¢ Methodaology 'EEB}vﬂﬂﬁvﬁﬁ@
7 S i 2 Needs updating
_ . Point Phasing ] Fisc
WEBS/CES Description Apprap | Unigue 1D Estimate | Msthod COMMEMTS (*) Comments Equation / Throughput You
25 COTS Hw 3800 FO01s* BY [Cost Throughput] 200
25 COTS SW $O0416 Ya
27 Praduct 1 3600 $0.102* | Meeds updating] 100/ 200
28 Product 2 3600 §0.050 % 50 Z0c
el Prorirt 3 SR sonmar E

15
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Definition Editor / Keywords Workscreen

16



 Documentation drop down menu
o Automatically integrated into documentation output

 Format meets OSD, Air Force and Army cost estimate
documentation requirements

°% File Edit Wiew

NEHR S

¢ Aial
b ethiodology
9a

: ¥ AF BAES PROGH

90  *Software

91  Application #
92 Application #
93 Application #
94  Software Pro

Documentation iEaIc Cazes Heportz  Tools  “Window  Help

Introduction = | & % j:a | <= »= | :

Hetholosy SR RERY EENI=REYER

Learming

Adjustrents ﬁ @ !

Wwihat if

Fhazing Al+F3

WBS/CES Aaniable  Chl+F3

RISK

Import » oy S

Load... SW:.-E

Unload... Sy L

Drefinition Cleanup. .. ovy
3600 oW F

95  Software Developrment Rate (3/MM)

17




* View/Edit definitions and descriptions of:
— WBS
— Methodologies
— Adjustments
— Learning Curve Parameters
— What-if cases
— Time-phasing parameters

e Stored on a row-by-row basis
e Format, view and print using Reports commands

18



e Automatic documentation placed into Keywords
workscreen:

— Using system WBS/CES indenture structure

— Extracting CERs from a library

— Bringing back a result from CO$TAT

YWEBS/CES Description Approp F'Chnadsee W&gﬁﬁﬁgﬁ hg:

i Miszion Analysis 3600

32 AF RAES Program DEVELOPMENT PHASE EmD

33 ELECTROMICS SYSTEM EmD ELECSY

34 FRIME MISSION PRODUCT (PMP) EmMD PP

35 RADAR SUBSYSTERM 3600 EMD RADAR

36 DATA PROCESSING EQUIPMENT SUBSYS ErD DPE
S Ll -
53 Application # 3600
54 FWP SYSTEM (SUFT) SOFTYWARE SUBSYS| 3600 EMD PMPSLPSW
55 FMP INTEGRAASSYCHECKOUT 3600 EMD FMPIAC NCERSOO1
A6 TRAIMING EmD TRMG
A7 EQUIPMENT

19



 To access:
— View > Keywords, or

— Workscreen dropdown menu > Keywords

ﬂ File  Edit | Yiew | Documentation Cale  Cazes BReportz:  Tool:  Wind
P 2 o =] Inputad Form.. Alt+F2 2| .6 % %
: ial E Inputz/Results Viewer . Chil+F2 u | LR '\.qeﬁ | E
; Kepwords ﬁ Arrange... Clrl+G .ﬁ ﬁ @
27 Ee s roduct 1
Learring Shift+Fg Apprap
25 Methodalogy Fa 360
26 Bl All Caluning
7| B3 Basic 360
28 Spread Total 360
2 WES/CES CuleFe 36
40 What if [read only) 3600
Bl Yearly Phaszi Alt+FS 0
+
= ‘fearly Phazing 20
I3 Al Colurmns M 601
3 Custom 1 VSTEM 3600
35 Custamn 2 jLTR ETC) 3600
36 Custom 3 _EMS (SFPECIR 3600
37 Toalbars [ E SUBSYS
35 3600
£oom...
39 FRTCETTETT 360
40 Application #3 360
A1 PP S¥STER SHPT SNFTWARE SHBSYS SR

hd ACE 7.1a - [AF RAES PROGRAM 200805133

[ File Edt Wiew

Documentation

LCale Ca

NS Hx SR & @S 9!

Al ~ 10

F.ewaords

|| Rl$k Al Columing

" A O

el NE AN
; Adjustmentsz

&

Learning
k ethodalogy

Ba/CES Descriptio

31

FI$k. Basic TS Hyly
| Spread Taotal
| 'WBS/CES TS 5W
What if [read anly] Praduct 1
early Phazing
| | All Columiz Product 2
E”S:':'m 12 Product 3
Lzkom
Cusztom 3 Product 4
Product &



* Displays a keyword (number) for each block of text that
IS not automatically generated by the session

e To access text, right click on cell > Edit Definition

u_ ACE 7.1a - [AF BAES PROGRAM 2008051 3.aceit - Keywords [BY20083M]]

ﬂ File Edit “iew Documentation Calc Casez Beports  Tools  wWindow  Help

NS HE SR %@ T 93K 6% % =F 100 -~

: drial 10 ~A-O- B 7 U (% k2R P E=E QS AE R
! Keywords 'EE_@'@@*?%@
50 - A
WBS/CES Description Apron | Cae | Dot | Desonpties | Desuintion | Docarmtin | Dusarption | De.
45 COTS SW 3600
47 SERVICES 3600 2
45 FACILITIES 3600
49 PECULIAR SUPPORT EQUIPMENT (PSE) 300 EMD PSE
500 SYSTEMS TEST AND EVALUATION 300 EMD SYSTE NCEREDDdl 11
51 SYSTEMS ENGINEERING/PROJECT MGT EMD SEPM | EditDefiniin..  Cul
52 Systems Engineering 3600 Eqguation Builder...  Chl+E
53 Frogram Management 3600 Calc Paint E stimate F3
54 DATA, 300 EMD DATA, ¥ oy
55 OPERATIONAL SITE ACTIWATION 300 EMD  OPSITEACT )
=4 Cnnw Chl+l™

21
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« After editing, make sure to Save

 To make same definition apply to multiple WBS/CES
items, copy keyword

hd ACE 7.1a - [AF BAES PROGRAM 20080513.aceit - Methodology Definition [ID: HCERS001]]

5 Eile  Edt “iew Inzet Fommat Toolz  ‘wWindow Help

Ehﬁ|ag|ﬁ%ﬁ§|TimesNewHDman - 12 - B I H|

M
Il
M
<
@.

T L TP L R T CEL R
L L L L L L L L L L L L
DEVELOPMENT COST FACTOR - Integration & Assembly {1 84)

_ BN [ ACE 7.1a - [AF RAES PROGRAM 20080513.aceit - Keywords (BY2008$M)]
DESCRIPTION - Estimates Development Inteqration 8 |4 fie Edt View Documentafion Cale  Cases

r—
r

Beports Tools  Window  Help

Froduct (PMP] less [8A" cost. This factor was updated: § o g s g 0 8 e @ 709 o | 2a e 6 % % <= = 10

-

oA . . o g ll: B _ - G= 4= L E,
SOURCE DATA - An analysis was made of 117 CPRs 1 MRS BE RHSIIER - TRERR Rk S B JE ECRCK
Allwere fram ESC Development contract efforts ooey 2 femers "REAR- Fu-AH0
were normalized to BYSY, k., using manthly QOS50 infla 45 - S 1y 2| ¢
St i sy ageous ot R e i
40 Application #3 3600
41 PMP SYSTEM (SUPT) SOFTWARE SUBSYS| 3800 EMD  PMPSUPSW
42 PMP INTEGR/ASSY/CHECKOUT 3600 EMD PMPIAC  NCERSOO1
43 TRAINING EMD TRNG
44 EQUIPMENT
45 COTS HW 3600 4
46 COTS SW 3600
47 SERVICES 3600
A0 Farl ITIF= ENN

22
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e 10 columns, plus the WBS/CES column:
— Appropriation
— Phase Code
— WBS/CES/VAR Definition
— Methodology Description
— Learning Description
— Phasing Description
— Adjustments Description
— What-if Description
— RI$K Description
— Methodology Library

23



 View > Arrange - to shift columns and customize
Avange Worksoreen |

C % File Edit | View i Documentation  Cale  Cazes  Repo GoTo workscresn Title: W
C 23 2 nput sl Forn. il T ' ' .
: arial B Inputs/Resuls Viewer..  Chl+F2 u ~ Awvailable Columnz Eezet | i | [ (=1 | [elete | [Erefaml |
: |ﬁ Arrange Ctrl+G | - '&'diusmd =E =
| Keywards &= EZF Allow RI$E When PE=0 — Column Arangerment
Adjustments .-i'-.lpha - - -
38 Comond Eeta Title wiidth dlign |~
v AFRAES | S - Beta % Spent rtide > | | [WBSZCES Desaripion o
Learning Shift+F3 — ] Beta  Time Approp £.0[Right -
Methodology F8 Eztauﬁeakness : Phase Code E0[Right =
Cateacy 1 CHE | | [wes /s /an Defitonkep_120[Right
Categary 2 kW ethodaology D ezcription Kewe 10.0|Right -
Cateqary 3 Learning Description F.eyword 10.0|Right -
EEEEDDW g i Phasing Description K.ayeard 10.0| Right -
E:tzgg:ﬁ B Adjugtments Description Fewwo 10.0{Right -
Category 7 ¥ What if Description Keyword 10.0{Right -
Cateqory 8 ;I RI%E. Definition K.eywaord 10.0{Right -
e b ethodalogy Libran Eewword 10.0]|Right -
Filker
i+ Dizplay all columns
™ Digplay what-if caze columnz
" Dizplay DECs
™ Dizplay categomy columns
— Column Headers I
i Height: |2
L) shor Tites s | [ oK | concel | Hep |

24



 Methodology Library Keyword:
— Link WBS/CES item to particular methodologies in ACE

Methodology Library Methodology
e CERs 1| Librany
e Factors
 Model functions —
— Keywords are system assigned RADAR
— Cannot edit these definitions bPE

25



NEHR &

¢ Aial

Fepmwords
41

=
[

41
42
43
44
45
46

=]
=]
TRAI
E

Methodalogy F3
Learming

Adjustments

“what if

Phasing Alt+F3
WEBS/CESAanable  Clrl+F3
RIS

Documentation > Introduction

" — Create or edit an introduction or overview of
E estimate

— You cannot enter an Introduction for each
line of the estimate

| rpart

Documentation > Methodology

Load...
Upload...

Drefinition Cleanup. ..

— Create or edit methodology definition
associated with the active row

SFERVIrFES

— If you copied or imported a CER from the
ACE Libraries, or if you are using a CER you
imported from COS$TAT, a definition
automatically displays

e Documentation > Learning

— Create or edit learning curve adjustment
definitions

— If you fit the learning curve with CO$TAT, the
COSTAT definition will display here

26



ocumentation | Lalc
NEHE S Introduction

¢ Aial

Fepmwords

41

Methodalogy F3
Learming

Adjustrment

“what if

Phasing Alt+F3

=
[

41
42
43
44
45
46

WEBS/CESAanable  Clrl+F3
p RIgK

P Irrpart

TRAI Load...
Upload...

Drefinition Cleanup. ..

QQQQQQQQQ

 Documentation > Adjustments

— Create or edit the G&A, fee, overhead,
escalation, and currency adjustment
definitions associated with active row

e Documentation > What-if

— Create or edit the What if or sensitivity
case definition associated with active row

e Documentation > Phasing
— Create or edit time phasing definition

27



e T Documentation > WBS/CES/Variable
O — Create or edit WBS or CES definitions
- w . — Create or edit definition for the input or
m SR G | variable the active row represents
= « e.g. the active row estimates WEIGHT,
u il et : which is a cost driver of the estimate
« Documentation > RI$K
— Create or edit documentation on RI$K
parameters

28



|0 ACE 7.1a - [AF RAES PROGRAM 20080513.aceit - Keywor :
ﬁ File  Edit View | Documentation h LCale  Cases  Hepoitz [ ) D O C u m e n tatl O n > L O ad

H0 S S | ] Invoduction =

” B — Opens Load Definition Dialog

: w = — Allows you to load or import ACE

i : w$N e [ c_lefinitions from a rich text form_at or Word
2 Pl npat | file that was created by unloading the

z T U | definitions

Load Definition x|

) Gurrently Gpened DEcuments

& Previously Saved Documents

I Browse. .. |
Ok, I Cancel | Help |

29
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u ACE 7.1a - [AF RAES PROGRAM 20080513.aceit - Keywor

‘Il Ele Edt View | Documentation | Cale Cases Repotts @
O0E 3= & Intraduction ? I'l
: ial Methodalogy F3 F K
. Learring
f oy Adjustments i ﬁ
4 “what if —
Phasing Alt+F3
0 WEBS/CESAanable Chl+F3 [
41 py o BN = sul
42 P Irrpart 3
43 TRA  Lgad.. I
44 E Upload...
45 Drefinition Cleanup. .. F
£

Thiz operation will copy your definitions to a Word document

or a RTF file, daing so will allovs pou to edit all of wour
definitions at ohce uzing a word processar.

™ List row numbers in definition marker that use definition

[™ Place defiritions in numerical arder of session keywards
[ Unload system definitions

™ Fill in keywaords for rows without definitions

— Fows to unload

& &l Fows " Selected Rows

r— Definition Types to unload
IV wES

M adustments M Risk  sojectal |

[ Methodology W Phasing
¥ Learning v Wihat if Select Mone |
r~ Destination

¢ word document = BTF file
(u] 4 I Cancel | Help |

Documentation > Unload

Opens Unload Definitions Dialog, which
allows you to unload or export ACE
definitions to a rich text format or Word
Format

Copies all definitions in session to a single
file with a text string like <ACEIT-
DEFINITION 3 on ROW 3> acting as
separator between individual definitions

When saved to computer, can be read and
edited by most word processors

Great way to edit all definition text at once

Once edited, load these definitions back
into ACE by clicking Documentation > Load

30



u ACE 7.1a - [AF RAES PROGRAM 20080513.aceit - Keywor

‘Il File Edit iew | Documentation | Calc  Cases  Repoits
NDEHS S Intraduction 3,‘ I
: Arial Methodalogy F3 F K
. Learring
ki Adjustments I ﬁ
al = what if -
Phasing Alt+F3

0 WEBS/CESAanable  Clrl+F3 -

1 Pl o B = sul

42 P Irrpart 3

43 TRAI Lgad..

44 E Upload...

45 Drefinition Cleanup. ..

46 T

A7 SERWVINES

 Documentation > Definition Cleanup
— Opens Definition Cleanup Dialog
— Allows you to delete any unused definitions

Dehnition Cleanup B I

" Show definitions stored in file but not used in session & Show all definitions contained in the session
i~ All Definitions (used and unused)
Kewward: Definitian;
Mo leatning, =
[ ]
Delete Delete All Print Close | Help |

31



e Reports > Generate
e Report Type - Narrative

u_ ACE 7.1a - [AF RAES PROGRAM 20080513 aceit - Keywords [BY2008%M]]

: ﬁ File  Edit “iew Documentation Cale  Cazes | Beportz | Tool:  Window  Help
NEHS A0 kD g9 o [ e Eaven P T i
¢ Auial - 10 + Av v | B Export Report Templates. .. - Report Type i I
: : Import Report Temnplates. .
: Keywords - = g 3~ 38 i P F Prirt |
i i [ (e i e
41 £ i PMPSUPSW Organize Favorites. . Al Session Spstem i oo |
Inflation Factors ~ Awailable Reparts
inti Export...
WWES/CES Description Equation Fesults BY'$ . ALE Narrative [Portrait] LI
40 Application #3 ACE Marrative [Selected Fows) @iEE m:;:::::z EEEFT:;E ?L?::Z]Scape] New
41 PP SYSTEM (SUPTJ SOFTVY B Phased [Selected Rows) ACE Marrative with RIEK [Selected Rows) ;
47 PMP INTEGR/ASSY/CHECKD B Phased (Landscape] ACE Marrative with BI$K Basic [Portrait] Edi...
T P Detaled Marmative Traceback for the Active Row
43 TRAINING T Phazed - Funding Only [Lands Marnative Traceback [Selected Rows) WEIEtS
44 ECILIPRENT I : :
ar Eaatan't ol BN L BN I i Inimim]

MHotes
Full D ocumentation [Fortrait] :I

Add Favaorite

[ el
Hedm

Help

Cloze

Pl LB LE
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Allows you to print, view, or export your narrative text on
a line-by-line basis

You can select an existing narrative report format to
view, export, print, add a new format, modify an existing
format, or delete an existing format

Copy text from the report using the Edit Copy command

You cannot type into the viewer and change its contents
or the ACE definition text

To exit viewer: click on box in upper left corner of the
viewer box, select close

33



e Use Word as your definition editor and to generate

narrative reports
* Tools > User Options

u. ACE 7.1a - [AF RAES PROGRAM 20080513 aceit - Keywords [B2008%M]]

ﬁ File  Edit “iew Documentation Calc Cases Heports | Tool: | Window  Help
NG EHE SR %G S 9 O Se3k E CERLbay..
¢ pial c10 < A-- B I U Y # POST/Exec wizard.. a=| Y
H —— - = I [1H
. BN WES Mumbering Wizard...
 Kepuords -DE@ L sa- Bl 0 T
ﬁ Phasing “Wizard...
“ L L@ PMPSRSH System By Site Wizad.
WES/CES Description . Equation Cleanup Wizard... | ~ Documentation
- - Eil'$F. Grouping and Correlati
40 Application #3 W Use selected case column a5 default case Tent Editar: IBuiIt-In ACE Editor j
41 PMP SYSTEM (SUPT) SOFTWARE SUg 3¢ RISK Custom EDFs.. '
S pssion Analuzer [ Position tatal of phased repart after yearly data Diefault fant f Microzaft 4o L

42 PP INTEGR/ASSYACHECKOUT B Builtln ACE Editor

43 TRAIMING ACE 40-4CE Plugin... v Automatically make rows visible in POST and Exec Fant... | Times Mew Roman, T pt.

44 Egéjé:—hgim Excelto-ACE Plug-n... Colar for locked cells and case colums: I E e

jg CoTe o ACEIT Admin ¥ Recently used fil list: Ig_:ll entigs Find functions and IDs using an interactive list

47 SERVICES Buidaizs Lecle.. ¥ Save recoven file every |1|:| _l: minutes I.&ulnmalically dizplay AutoComplete j

User Optionz... . . .
48 FACILITIES | ,_SEI g Io.m - [ Suppress syntax check completion dislog v Paste parameters to functions and UDFs
49 PECULIAR SUPPORT EQUIPMENT (PSE) | 3600, EMD ; ;
 Input Al Dialog i Sheet Behavior
[ Show advanced row zettings in dialog Move directian on Enter: IHith j
1= [per ta | aebtat displaved|in dislzg (advarced) [T Sort bookmarks alphabetically
Ok, I Cancel | Help |
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« Greater flexibility and more
options when editing

ﬂ__ ACE 7.1a - [AF RAES PROGRAM 20080513.aceit - Kepwords [BY20083M]]

definitions or repOrtS Bl Edt Wiew | Docurerision | oo Casss Bepots Took window Help
. DEHZ| S |ntroduction ?‘ | & % %| <= 5= | 100%
e How it works: S TNy
= P *
— When you create a new 5 . ot
. e . . . Eresivg A3 Approp Phase | YWBSS
definition or edit an existing e i Code | RD:
A0 - 3R00
one, ACE opens Word 41 ol HIK fcuBsYs| 3|0 EMD PME
: — 42 P mest ] noducton
— Create or edit the definition e TR Lo Methodelegy
nload... Leamning
— Format text as deS"'ed j: _ Defrion Clearu . gdiu$twents
. 47 SERVICES W'bat- if [read anly)
— Return to ACE and import 8 FACILITIES o
P 459 PECULIAR SUPPORT EQUIPMENT (R = anable
the new definition 50 SYSTEMS TEST AND EVALUATION itk
51 SYSTEMS ENGINEERING/PROJECT MGT | EMD

 Documentation > Import



1513 aceit - Methodology [BY 2008%M]]

Reports > Generate > it o | Lot tien ter

| o |

Generate [Edit, Yiew, Print]... Fi0 |

Select desired report,
click Export &:2

COoTS

Specify a filename for e
the report 7 s0FT

All reports except

. g
Ezport Report Templates... b= 0= | nl!ﬁ | §

Import Repart Templates...

narrative are TXT files;
Narrative reports are
RTF files

TXT files can be
Imported into Excel and
RTF files can be
Imported into Word

Orgarize Favontes.. Chl+F10
Inflation Factors pint Pha
Equation Results BY'$ imate | Met
&CE MNarrative [Se e
BY Phased [Selec et Tae view
BY Phased [Lands IF'hased j |
T% Phased - Fund Print |
I Lol | " Session € Spstem
| = Print Presview |
dwvailable Reports
| E=part... |
(& B Phased Results [Landscape]
# BY Phazed Results [Selected Rows)
Phased BY Cost Fows [Landzcape] MNew... |
# T Phazed Funding R equirements [Landscape) i
T Phaszed Funding R equirements [Selected Rows] Edi...
Uelete |
Remove Faw

Motes
All Bows & Vears [Landscape)

|

N




 Document all changes made from version to version of
an estimate

* Find your preferred method of documentation and follow
a format — be consistent

e Document AS YOU GOl
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Questions?
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ACE 7.1a Help Menu
ACEIT 7.0 User Guide

Presentation, “The Power of ACEIT Reporting,” ACEIT Users’
Conference, 24 January 2007

www.ACEIT.com

Article, “Including Notes or Category columns in ACE Narrative
Reports,” www.ACEIT.com, article ID# 1247, 6 February 2008

Contact Info:

— MTeicher@mcri.com or Melissa.Teicher.ctr@hanscom.af.mil
— Office: (781) 377-1068
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